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In the case we're looking at, you use Excel to harness the built-in capabilities of Word. The purpose of doing this, in this case, is to convert the contents of a PDF file to Excel. For purposes of using Automation, the main thing you need to is create a connection between the relevant applications. In this particular case, those applications are Word and Excel. In the sections below, I provide samples of VBA code that use both early and late binding.

In the section containing the code sample that uses early binding, I also show how you can create a reference to Word's object library. The basic steps of this process open file, copy and paste are roughly the same as the steps followed by the previous macro examples 1 using Adobe Reader and 2 with Able2Extract.

Therefore, you may notice that some lines of code are substantially the same as those used by the previous samples. I explain each of the lines of code below. When appropriate, I refer to the equivalent lines of code in previous sections.

However, since this particular macro uses early binding, you must start by setting up a reference to the relevant object libraries. Let's start by taking a look at this:. In order to create these references, go to the Visual Basic Editor and follow these 4 easy steps :. Once you've set the object reference, you can access the Word object model and use the objects, methods and properties it contains.

The purpose of the myWorksheet object variable is to represent the Excel worksheet where the data within the PDF file is pasted. The main purpose of this line of code is to create a variable representing the Word application in order to expose the Word object model. The purpose of this line of code is similar to that of the previous line 2. More precisely, this line 3 creates the variable that provides access to the native Windows shell.

I explain why myWshShell is required when explaining line 13 below. Its purpose is to declare a variable that holds the path to the PDF file you want to convert to Excel. It uses the Set statement to assign a particular worksheet Word Early Binding of the active workbook to the myWorksheet object variable. Both of these lines of code use the Set statement for purposes of assigning a new New instance of the relevant object to the applicable object variable. This line of code uses Word's Application.

Version property wordApp. This property returns the version number of the relevant Word version. That version number returned by the Version property is assigned to the wordVersion variable. The expression on the right side of the assignment operator is created by concatenating the following 3 items:. In order to understand why this statement is necessary, let's take a look at what happens when you manually open a PDF file using Word :.

Additionally, you have the option of specifying that the message shouldn't be displayed again. To do this, you just need to check the relevant box that appears on the left side of the dialog box. Clicking the OK button manually is quite easy. At first glance, this is something that would also be easy to handle using VBA. The key that corresponds to the value written to the registry doesn't initially exist.

In order to proceed with the PDF to Word conversion, you must solve this. The statement uses the RegWrite method of the WshShell object. You can use the RegWrite method for 3 main purposes :. The practical effect of this line of code 13 is that the warning in the dialog box that I explain above regarding the PDF to Word conversion is turned off.

Therefore, Visual Basic for Applications is able to proceed with…. Lines 14 to 16 are a single statement. The statement calls the Documents.

Open method. This method allows you to:. Notice that the statement we're analyzing only makes reference to 2 of the parameters of Documents. Open :. As a consequence of the above, the practical effect of lines 14 to 16 is that Word opens the PDF file you want to convert to Excel.

The only difference between lines 15 and 17 is the value assigned to the anyValue parameter of the RegWrite method. In practice, line 17 reverses what line 15 does. In other words, it turns the warning regarding the PDF to Word conversion back on. Other than the above, the general aspects within the explanation I provide in line 15 above are applicable.

Uses Word's Range. Copy method for purposes of copying the content of the file you want to convert. Within this line 18, this Range object is that returned by the Document. Content property. When you use Document. The Document object to which the Content property makes reference to is the active word document returned by Word's Application. ActiveDocument property. The practical effect of With… End With is that the series of statements within the block are executed on the same object.

In the case of the sample macro we're looking at:. The whole With… End With block composed by lines 19 to 22 of this sample macro has substantially the same effect as lines 17 to 20 of the previous macro examples.

This line of code is the same as line 18 of prior code examples. It uses the Range. Select method to select cell B4 of myWorksheet. This line sets the location where the data from the PDF file you're converting is pasted.

This statement is needed because it's required by the Worksheet. PasteSpecial method used by…. More precisely, it uses the Worksheet. PasteSpecial method for purposes of pasting the contents of within the Clipboard on the selected range see line 20 above using a particular format. Uses Word's Application. Quit method to close Word without saving the file changes. For purposes of this tutorial, you only need to be aware of the following 2 items :.

Both lines of code use the Set statement to set the wordApp and myWshShell object variables to Nothing. The reason these statements are included is to release the memory. The only difference is that, instead of using early binding, this sample 4 uses late binding.

The macro, therefore, follows exactly the same 3-step process to convert the PDF file to Excel :. There are only a few differences between the 2 macro examples that rely on Word to convert a PDF file. I highlight them in the following image:. I explain these differences in the following sections. Other than these clarifications, the comments I provide above when explaining macro example 3 with early binding are roughly applicable to this macro.

Both of these lines of code use the Dim statement to declare an object variable. Furthermore, in both cases, the object variable is declared as an Object. This declaration as Object forces late binding. These lines of code are the equivalent of lines 2 and 3 of the previous macro example 3 that uses early binding.

In that case, however:. The consequence of this difference is that both macros paste the data from the PDF file in different Excel worksheets. This difference, however, isn't strictly related to the topic of early binding vs.

It's simply a consequence of the way in which I create and organize the sample workbooks that accompany this tutorial. In the previous macro example 3 with early binding , the object references are created in the same lines 8 and 9.

However, in those cases, the object reference is created by using the New keyword instead of the CreateObject Function. This line of code achieves exactly the same purpose as line 23 of the previous macro example 3.

The consequence of this line is, therefore, that Word closes without saving the file changes. The only difference between the syntax used in the macro that uses early binding and here is the way in which the value of the SaveChanges parameter is specified. In the previous example, this was specified as wdDoNotSaveChanges.

Here, it's assigned the value of 0. Now that we've covered how you can use Word to extract data from PDF to Excel using VBA, let's take a look at the results I obtain when executing the sample macros 3 and  The VBA code examples 3 and 4 are materially the same.

The only difference between them is the fact that 3 uses early binding, whereas 4 uses late binding. As a consequence of the above, the results I obtain when executing both macros are substantially the same. Therefore, in the images below, I only show the results I obtain when executing the early binding macro version. At first glance these results seem to be very good.

In particular, i the values seem to be appropriately extracted and ii the structure of the original file including its tables seems to be well replicated. However, upon scrolling down the file, some issues become evident. Check out, for example, the following screenshot and notice how the 2 rows I highlight. As evidenced by the above screenshots and previous conversion results within this blog post here and here , the macro example that relies on Word for purposes of converting a PDF file to Excel is generally :.

Microsoft explains the reasons why Word may not accurately convert a particular PDF file here. Navigation Pane Settings - for Word and later. In Word Navigation Pane settings are not "sticky. In Word , when Word starts, the Navigation Pane is displayed or not depending on the setting when it was last used. Contains optional code to also set width of Styles Pane. This zip file has an Add-In that gives the user control over both. The template is its own Read-Me file with documentation.

Addressed error thrown in recent versions after Office Release in September of  Uses an AutoText entry. Macro would not be needed except for the date stamp. Chris Woodman's Keyboard Shortcuts Organizer - very good - his web page has been down for some time.

Here is a link to the archive page. Below are links to my ribbon version. A link in my download will take you to the original. The screenshot above is from Word  This is old software but it can be made to work.

I do not know of anything else available to copy keyboard shortcuts. In Word and later, both the original and the modified version require that the Trust Center Settings be set to trust access to the vba project. This is not a usual setting. I incorporated the code from this in a version for Word and later that adds a group to the Developer Tab.

Pressing the shortcut again gives you the field results back toggles the display. I have a very short attention span and forget to toggle back. I find it annoying and created this little Add-In to help with this. It automatically turns off display of field codes whenever a document is opened or created. Intermediate Users' Guide - - - - - - - - - - - - - - - - - - Questions List. Alternative placement! You can download that macro-free modification by clicking on the screenshot below.

It is in a zip package and is version  Chris Devrell Downloads Page - Utilities toolbar, sample userform to get information for letter. This is on the OfficeVBA site which is member-only. Don't despair! You can sign up for a free issue of the magazine and get 30 days of free access to the site. This site is so good I ended up paying for a subscription to the magazine just for these download privileges. You don't really need to read the articles, just download the utilities. The articles, though are good if you are trying to learn VBA because they explain in great detail what is being done and why.

Although you will want to read both articles Thesaurus and Speller you only need to download the Add-In from the Speller article. Put in location where macros can be used. This can be corrected with the zoom screen controls in Print View. In the MacroButtonPrompt Add-In there is a Word version that incorporates a workaround until such time if ever that this bug is fixed.

This bug is discussed in Word Answers in this thread. Web resources for Microsoft Word - templates listing. Check the personal sites of the Word MVPs. They often have very useful downloads.

Smilies from Woody's Lounge. Intermediate Users' Guide - - - - - - - - - - - - - - - - - - - Questions List. Charles Kenyon with input and suggestions from many on the Microsoft Newsgroups and at Woody's Lounge Click here to skip past FAQ questions list and other info and go directly to the start of this topic.

Letterhead AddIn s - Created to assist someone who mistakenly wanted to make the letterhead the normal template for all people in the company. Adding text to the normal template including headers or footers or page numbers is a very bad idea.

The zip file contains two versions. The first creates a new letter based on a letterhead template in the workgroup template folder when Word is opened. The second is a single template to go in the Word Startup Folder which acts as the template for letters. In either version the tempate becomes the default new document without replacing the normal template.

This Add-In changes the default template for new documents, without changing the normal template. Although the title is "Letterhead," it could be any document format. This includes documentation and instructions for modification.

For Word and later only, although concept would work in earlier versions as well. Download Letterhead Addins. Letterhead system. This is a system for self-updating letter forms. The idea is to have letterhead components stored in one location and have letter forms reference that location when used so that form letters will have the latest letterhead information. If you are generating your letterhead on the computer or if your letter forms need to accommodate pre-printed letterhead, you should look at this!

Gender Toolbar - Lets you use a custom document property to make gender-specific fields in Word 97 -  Zip file - Version  Adds these options to the Insert tab on the ribbon. Unobtrusive - powerful! Disables Web toolbar and provides menu command for you to view the toolbar when you want to. Download Web Toolbar Handler Now. This is assigned to a printer icon on the QAT for versions and later. Download zip file contains a.

Only one should go into the Word Startup Folder. Released  Most uses work better with a CreateDate field that gives you the current date when you insert it and remains that same date. When used in a template, it is updated when a new document is created. Also, people may prefer a long date rather than the short date. It also has instructions for changing the format and has several options.

Works in Word  This Add-In contains no macros. This contains Page Number entries for direct entry that include fields like page numbers formatted for Roman numerals, the FileName field, and FileName with Path field. Can be used in conjunction with the FileName and Path Add-In which contains a macro to insert the filename at the insertion point. The rulers are still displayed. Unlike the AutoHidden Ribbon, this does not require the full screen and is not "sticky.

Download Toggle Toolbars Add-In. This imports the Body Text and all 9 heading styles from the global template. Has keyboard shortcut to do this as well as keyboard shortcuts for Heading Styles  Zip file with. Use only one of the templates. Contains macro to remove numbering from heading styles written by Stefan Blom as well as a toolbar in the.

Also includes optional body text styles to match the indents of the headings. Also includes a separate sample that copies all styles in the template into the active document. Download the Global Stylesheets Add-In. Zip folder containing. For Word  Macro-free version released  The one on the left gives access to the Quick Styles Gallery from the Home tab. The text Drop-down is the legacy Styles drop-down from menu versions of Word. The third opens the Styles Pane giving access to other controls.

The fourth one launches the Styles Organizer. The screenshots below show the Styles Gallery and the legacy Styles drop-down. There are no font dialog controls for these in Word and the later ribbon versions of Word.

A macro can still insert such text or you can simply put text that already has the feature you want into your document and it will retain that character. Such a macro written by Greg Maxey can be found here. Text that has these effects applied keeps the effect when inserted or pasted into Word  You can then replace the pasted text with anything you want.

The download has samples of all six text animation effects. The zip file contains a. The template can be placed in the Word Startup Folder or in your Building Blocks folder to make it global. It contains AutoText entries but no macros. The names of the AutoText entries each begin with the letter "x" and are listed in the template. Current version is 4.

See page 2 of this thread on the Microsoft Answers Word forum. Also contains a separate. See Doug Robbins' answer in this forum thread. This has a different button on the QAT. These can work together; however, I can't think of a reason to use both. It adds a header and footer with a content control for typing like Word as well as a truly empty header and footer to the choices available. Note, if you have a version of the Building Blocks file, you can use that as a global Add-In. I would recommend renaming, it, though.

This is the default setting in Word so you shouldn't need this often. Page numbering can get messed up in multiple-section documents and can be difficult to fix manually. This button triggers a macro to do it. The macro is based on one written by Jay Freedman.

The macro is shown in the Add-In text and can be copied. This does not add or change page number fields; it makes sure that the numbering does not restart anywhere in the document. After it is clicked, the user has a chance to cancel. Once it has been run, the user can choose to restart page numbering in any section using the Format Page Numbers dialog. Also contains a. This has been tested in Word , but does not work in Word  It may work in Word and but has not been tested.

This macro-free Add-In gives the users a custom AutoText gallery on the Quick Access Toolbar that allows use of the traditional choices as an addition to the WordArt directly available in Word -  For a discussion of alternatives, see this thread on the Microsoft Answers Forum.

This also includes some simulations of classic WordArt done using the new graphics engine. Download WordArt for Word Normal. Last Updated: May 26, Tested.

Luigi has over 25 years of experience in general computer repair, data recovery, virus removal, and upgrades. He is also the host of the Computer Man Show! The wikiHow Tech Team also followed the article's instructions and verified that they work. This article has been viewed 4,, times. Do you want to convert your Word document into an easy-to-send PDF file? PDFs are compatible with all platforms, so turning your Word document into a PDF ensures that more people can open the file.

Click Choose file. Double-click the Word file you want to convert. Did this summary help you? Yes No. Log in Social login does not work in incognito and private browsers. Please log in with your username or email to continue.

No account yet? Create an account. Popular Categories. All Categories. Edit this Article. We use cookies to make wikiHow great. By using our site, you agree to our cookie policy. Cookie Settings. Learn why people trust wikiHow. Download Article Explore this Article methods. Tips and Warnings. Related Articles. Article Summary.

Method 1. Open the Microsoft Word document. Double-click the Word document to open it in Microsoft Word. If you haven't yet created the document, open Word, then click Blank document and create the document as needed before proceeding. Click File. It's in the top-left corner of the Word window. Doing so opens a pop-out window. Click Export. This option is in the left-hand column of options. You should see several new options appear in the middle of the window.

It's in the upper-left corner of the window. This option is in the middle of the window. Doing so prompts a pop-up window. Select a save location. On the left side of the window, click the folder in which you want to store the PDF version of your Word file. You can also enter a new file name in the "File name" text box if you like. Click Publish. It's in the bottom-right corner of the window. This will create a PDF copy of your Word document in your specified location.

Method 2. If you haven't yet created the document, open Word, then click Blank Document and create the document as needed before proceeding. It's in the upper-left corner of your Mac's screen.
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In this free Word tutorial, learn how to format text, save and share documents, modify line and paragraph spacing, use tables and columns. This booklet is the companion document to the Intro to Word workshop. It includes an introduction to the interface, and covers the. A word processor is a computer program that allows you to create, edit and produce text documents, such as letters. Microsoft Word is a word.
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  Looking for:  Windows 10 themes for pc.Best Windows 10 Themes in 2021  Click here to DOWNLOAD           - The 10 Best Windows 10 Themes for Every Desktop    Furthermore, the theme offers an extensive collection of wallpapers and it also has a dedicated dark mode. Download Blue Water theme. Download Feather Photos theme.        















 - Download Gangstar Vegas for PC (Windows 10,8,7) - AppsForWindowsPC




  Looking for:   - Gangstar Vegas - Mafia action on PC: Download free for Windows 7, 8, 10, 11 version  Click here to DOWNLOAD          Gangster Vegas: City Crime for Windows 10 - Free download and software reviews - CNET Download.Gangstar Vegas - Mafia action for PC - Free Download: Windows 7,10,11 Edition    Feee us: contact xeplayer. Use BlueStacks Macros to skip the predictable tasks and execute it with a single keystroke. Gangstar vegas for pc windows 10 free Mike. Yet another popular Android emulator which is gaining a lot of attention in recent times is MEmu play. Once it has been installed, open the program and sign in using your Gmail account or create a new one. Was the setup process hard? After installation, the Amazon Appstore and the Windows Subsystem for Android Settings app will appear in the Start menu and your apps list.        Gangstar vegas for pc windows 10 free.Gangster Vegas: City Crime for Windows 10      Free Download and Install Gangstar Vegas: World of Crime F
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  Looking for:  Download PrintKey   Click here to DOWNLOAD       Printkey – An Oldie but a Goodie – David Vielmetter    Printkey is a free screen printing tool. Main features: Print your screenshots for quick screen grabs on the go. - Configurable hotkeys. PrintKey (Printkeyexe) free download, latest version ✓, Printkey is a screen capture tool with print support.      Download Old Versions of PrintKey for Windows - .PrintKey - Wikipedia    Screenshot capture tools have come a long way, but older programs often still prove useful, especially if you are accustomed to a certain workflow. You tor find that an application you were using years ago is still the best one for the job.  PrintKey is a screen capture program that, despite being released nearly two decades ago, still seems to work mostly error-free on the latest operating systems. It comes with a bunch of useful features, but it is certainly showing its age. Even though it can be considered ancient at this point, PrintKey offers m
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